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TEACHING & 
LEARNING 
CONFERENCE 
TIPS

The following tips you can incorporate into your class are 
taken from the sessions offered in the 2022 Teaching and 
Learning Conference. References and citations for any 
data or statistics listed here can be found in the videos 
posted on our YouTube channel at www.youtube.com/c/
ndsuotl.

Videos in Classes
1. The four types of videos you can use in your course 

are: microvideos, tutorials, lectures, and screencasts. 
2. Adding video to a course increases engagement and 

is 83% more effective for retaining information.
3. Pre-recorded videos allows students to rewatch or 

prewatch videos to learn in their own way and time.
4. Offering videos reduces cognitive overload for your 

students.

Mental Models or Systems Models
5. Mental models or systems models are the top 

student-ranked most helpful technique or strategy, 
even when the instructor isn’t using it in their class.

6. Mental models help you evaluate the starting points 
of your students. If students can work backwards, 
forwards, and in all directions within a concept, then 
they have deep understanding.

7. Mental models work best over time and in groups. It 
is cognitively demanding to work alone.

Alternative Grading
8. Equitable grading strategies include: optional 

retakes, which can be split out by topic; flexible 
deadlines; limited grading of behaviors; equitable 
grading scales; and ungraded formative assessments.

9. Use homework and class time as opportunities for 
learning and feedback. Learning happens through 
mistakes.

10. Grades promote risk aversion and encourage 
performance over mastery. Grading everything 
equates to constant judging.

Adult Learners
11. In adult learning the instructor is the facilitator who 

helps students navigate their learning.
12. You can promote independent learning in your class 

by slowly removing any supports throughout the 
semester.

13. Connect adult student’s learning with life experiences.
14. Adult learners tend to learn more from their peers.
15. Practice the See, Do & Teach method with adult 

learners because they learn better when they have 
to teach someone else a concept.

Language Diversity
16. Recognize there is language diversity in every class; 

it may be through different languages, different 
regional or cultural dialects, or even familial usage 
of the language.

17. If personal interactions are pleasant, people are more 
willing to take on the cognitive load of listening to 
an individual with an accent. Facilitate pleasant 
interactions with your students.

18. Students have a higher cognitive load when they are 
worried about grammar. Consider not grading based 
on language and grammar usage when the concepts 
are the most important thing to learn (ex. discussion 
boards).

19. Grammar is the first thing to breakdown when 
learning new concepts.

20. Be specific about grammar expectations in your 
assignment rubrics.

Helping Students Write Better
21. Provide students with many examples of good 

writing in your field.
22. Instruct students on the writing process, which 

is: planning, drafting, sharing, evaluating, revising, 
editing, and publishing. Many students do not know 
the process.

23. Hold group discussions to give good quality feedback 
and to discuss their struggles.

24. Peer editing helps students analyze both good work 
and their own work.

Student Wellness
25. On your syllabus include on-campus resources 

for wellness and a statement of wellness. Assign 
wellness-related tasks like writing a paper on their 
wellness plan or touring a wellness resource.

26. In class, use clickers to allow students to anonymously 
gauge how they are feeling today.

27. Be a wellness role model for your students.
28. Offer flexible homework submissions (ex. videos, 

creative writing, etc.), adjust your deadlines to 
promote better sleep for your students, and 
consider offering extra credit or make-up points for 
participating in wellness activities.
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For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

Racial Achievement Gap
29. If you can adjust a student’s mindset you can help 

them have better outcomes.
30. Racial achievement gap was two times higher in 

classes with instructors who have fixed mindsets.
31. Instructors with a growth mindset tend to include 

why a student is learning a concept in their class.
32. Cognitive resources are split when a student is actively 

trying to avoid being stereotyped, which lowers their 
performance.

33. Active learning strategies have a disparately positive 
result for students of color.

Learning By Doing
34. Students need to see that you aren’t perfect, and you 

deal with the same issues they do.
35. Give students many examples of why they need the 

skills you are teaching them.
36. Bring in concepts that fit with the data they are 

working with.
37. Teach your students to self teach. Google is your best 

friend.

High & Low Technology for Rapid Feedback
38. Some high-tech tools that are fast and provide quick 

formative assessments include: clickers, Google 
products, diagrams.net, free polling software, Zoom 
chat, and Zoom polls.

39. A useful, low-tech tool for formative assessment is 
a color-coded card that corresponds to the answer 
choices. Students then raise their cards with their 
answer.

40. Don’t be afraid to improvise in your class.
41. Share the polls with your students and why you are 

doing them.
42. Let your students know it is okay to say, “I don’t know.”

Supporting Students in a Pandemic of Grief
43. Allow students space to share their story or speak 

about grief in class. Consider using a Blob Tree image 
to facilitate discussion.

44. Behaviors students might exhibit in class might reflect 
the stages of grief; be aware of the stages of grief.

45. Sometimes what we see as disengagement from our 
students is actually a grief response.

46. When a student is going through something big, 
they may tend to be more forgetful, have difficulty 
concentrating, and difficulty making decisions 
because our brains can only process so much.

47. Validate your student’s losses.

Flipgrid
48. Flipgrid is a free educational platform.
49. You can use Flipgrid to: encourage effective learning 

strategies, provide personal and direct feedback, and 
foster a sense of community.

50. Ask your students to connect a concept to something 
in their life, have them post a video discussing it.

51. Use video to provide feedback to students so they can 
hear your voice, inflection, tone, and see your non-
verbal cues. It is less formal and faster than written 
feedback.

Trauma Informed Practices (TIP)
52. If stress is detected in your learning environment, 

learning will be more difficult for those impacted by 
trauma. If you, as the instructor, project stress your 
students can pick that up.

53. Individuals who have endured trauma have a harder 
time switching out of fight or flight mode and back 
into a more productive way of thinking.

54. Some of these everyday learning experiences can 
activate a trauma response: lack of choice, team 
building, unclear rules, ambiguity, and forced sharing. 

55. Conduct a trauma walk through on your classes. 
There are formal assessment tools available to help 
with this.

56. Assess your teaching through these six key principles: 
safety; trustworthiness and transparency; peer 
support; collaboration and mutuality; empowerment, 
voice, and choice; and recognizing cultural, historical, 
and gender issues.

57. You might see the following responses in a student 
impacted by trauma who is currently in a fight or 
flight mode: difficulty focusing, attending, retaining, 
or recalling information; absenteeism; fear of risks; 
trouble with emotional regulation; anxiety about 
deadlines or coursework; withdrawl or isolation; 
unhealthy relationships; or nothing at all. Trauma 
informed practices is based in equity, meaning you 
customize the tools for the individual’s strengths. 
Don’t assume that a person has had a trauma, but 
know it is a possibility.



For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

TEACHING & 
LEARNING 
CONFERENCE 
TIPS

The following tips, you can incorporate into your class,  
are taken from the sessions offered in the 2021 Teaching 
and Learning Conference. References and citations for 
any data or statistics listed here can be found in the 
videos posted on our YouTube channel at www.youtube.
com/c/ndsuotl.

Teach With Empathy (Not Sympathy)
Sympathy is not empathy. Sympathy is a feeling of pity and 
sorrow for someone else’s misfortune. Empathy is a way 
of connecting with people that shows you understand 
they are experiencing something meaningful- even 
though you may not understand exactly how it feels 
for them. Instructors high in teacher empathy do not 
lower standards; they identify and remove obstacles to 
learning.

Get To Know Your Students
In order to make an impact on students’ lives you need 
to understand them first. You can do this by deploying 
a student survey. You can ask students to write a “This 
I believe…” essay. You could also ask students to create 
their reflexivity statement.

Adopt A Growth Mindset
Help students adopt a growth mindset. This is the belief 
that I will need to persevere through difficulty before I 
succeed. The desire to work hard consistently with the 
courage to ask questions when confused.

Inclusive Course Policies
Design course policies that reflect a deep understanding 
of students’ personal and social situations – Incorporate 
course policies for greater inclusion and equity. Inclusive 
and equitable teaching provides opportunities for 
success for students from ALL identities. 

Build Trust With Your Students
Trust your students, assume they are trying their best. 
Recognize each student has different pressures on 
their time and energy. Help your students understand 
the learning goals. Tell them the “why” behind each 
assessment.

Collaborate With Students
Let students lead the learning process by collaborating 
with students to discuss progress on meeting their 
learning goals. Invite students to set personal learning 
goals within the domains of the course. Enable students 
to complete self evaluations and reflections across the 
semester. You might also reconsider strict deadlines.

Ease Asynchronous Learning
For asynchronous learning, make it easy for students 
to access materials – make it obvious where to start, 
mention clear, attainable goals and objectives. Mention 
the standard methods of submitting assignments.

Create An Organized Course
Create streamlined content for students to follow. 
An organized course is the key to student success. An 
unorganized course will cause delay in assignments 
being completed. Make Blackboard navigation easier. 
Allow for students to have easy, accessible, and organized 
materials on Blackboard.

Be Flexible With Your Students
Flexibility improves the learning experience of your 
students. Post notes, assignments, class materials at least 
5-7 days before deadlines. Provide structure by having 
assignment deadlines but have a flexible deadline policy. 
Allowing students to resubmit assignments or retake 
tests increases their motivation to learn.

Create An Engaging Learning Environment
Using a variety of ways to display and provide 
information is optimal for desired learning outcomes. 
Offering opportunities for choice and autonomy is one 
way you can create a more meaningful and engaging 
learning environment. Often students do not understand 
or appreciate the reason why what they are learning is 
important. Establishing the “why” behind what you teach 
will help your students see relevance and value in the 
material.

Use Creative Ways To Engage Students
Instructors can use creative ways to engage students. 
For example, Dr. Sylvio May presents finger puppets 
alongside his presentations about the specific scientist 
being discussed. Dr. Beena Ajmera created themed weeks 
for students to create backgrounds on Zoom to fit into 
the themes. Dr. Jenny Linker shared how she used Swivel 
software in the classes she holds in the gymnasium. The 
camera follows the professor and can be integrated into 
Zoom.

2021 
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LITTLE HINTS 
To Use With Your 

STUDENTS
Advising Edition

Providing little hints throughout the semester can help 
your students succeed. Use the content on this printable 
to provide a new tip for your students each week during 
your regular class session. Some tips have suggestions 
for you in parenthesis. You may use this list as written 
or you may pick and choose which tips to use based on 
your specific class demographics.

Week 1
Ensure your class registration is final, inquire about wait 
lists if needed, and introduce yourself to your academic 
advisor.

Week 2
Identify the office hours on your syllabi for each class 
and keep the list handy for when you need them!

Week 3
Find a good study space on campus that works for 
you. Spaces include your residence hall/apartment, the 
library, and outside some classrooms. There are a lot of 
great spaces around campus!

Week 4
Check on your current grade and attendance for each 
class. If you missed assignments or quizzes can you make 
them up? What else can you do to get back on track?

Week 5
Have you sent or received any emails from your advisor 
yet? If not, now is a great time to have an initial meeting 
to start to discuss your interests in the major.

Week 6
Learn about academic organizations to get involved with 
for your major. (Highlight a few that are relevant to your 
department or program.)

Week 7
Browse your major department’s webpage – view faculty 
bios and learn about their research interests. Can you 
get involved with their research or other opportunities? 
(Share a few minutes about something you are working 
on and how undergrads have been or could get involved.)

Week 8
Midterm of the semester – check in with faculty members 
again and prepare for midterms. Look ahead for any big 
final projects.

Week 9
Take a look at your Degree Map and familiarize yourself 
with the academic requirements for your major. You can 
plan a tentative list of classes to discuss with your advisor. 
(https://ndsudm.civitaslearning.com/)

Week 10
Think about Spring registration and meet with your 
academic advisor.

Week 11
Take note of your current grade in the class and remaining 
work. Do you need to consider a withdraw from the 
course? Discuss options with your instructor and advisor. 
(Put a note on the syllabus/weekly tip that you are willing 
and open to chat. Students may need the reminder it’s 
okay to visit.)

Week 12
Check your Campus Connection account for any holds 
that may prevent timely registration for next semester. 
(https://www.ndsu.edu/onestop/holds)

Week 13
Register for classes as close to your assigned registration 
time for best availability of classes and class times. 
(https://www.ndsu.edu/onestop/registration)

Week 14
Put together a study plan for final exams.

Week 15
Make use of any study sessions offered. (List study 
sessions for your class.)

Week 16
Reflect on how the semester went and what adjustments 
you might want to make.

Inspired by a We Learn Together Blog post titled, Being First, in which 
a student named Hajira greatly benefitted from the little hints her 
instructor gave. Read about Hajira and other first generation students >> 
(https://www.dce.ndsu.nodak.edu/otlweb/blog/being-first/)

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started

https://adfs.ad.ndus.edu/adfs/ls/IdpInitiatedSignOn.aspx?SAMLRequest=fZHLboMwEEXX%2FQvkPS9DXqOAlCqLIrVK1KAuuqkm2EkswUAZu8rnF0gX6SbeeXzm3pnrNWNTd7Bx9kLv%2Bttptt61qYlhesiE6wlaZMNA2GgGW8Fh8%2FYKMoig61vbVm0tvOE8bYdeQ2hNS5m4WNsxhCGqEweoAlKOA63cVAhrDgvVFWSsQavVwZxpRwFyd52kim0mvmJ5Ws2Wq%2FQYJ3Gq9Cw9Latokc7nx1TPkkVyI5mdLogtks2EjKT0o5UvZSklRDHE8nPC9n%2BDPhtShs6PtzreIIaXstz7%2B92hFN6H7nnaawBEvh6zgcm7v0vrsSwy634MR%2BQjhkPiEVTmx1jkWmNPgyeQYqcaf1Rbh3cu%2Be32%2F6PyXw%3D%3D&RelayState=8w06aiCj3_dbsXDSLNaLZpC-TYovdB2F
https://ndsudm.civitaslearning.com/
https://www.ndsu.edu/onestop/holds
https://www.dce.ndsu.nodak.edu/otlweb/blog/being-first/
https://www.dce.ndsu.nodak.edu/otlweb/blog/being-first/


CREATING 
ACCESSIBLE
DOCUMENTS
Email - Microsoft Outlook 

Use this list to check for common accessibility issues in Emails. 
This document specifically addresses Microsoft Outlook as that 
is the campus-supported software. Microsoft offers step-by-
step instructions on how to fix accessibility issues, and further 
explanation on why these are important. Use this quick tips 
sheet to meet the basic accessibility requirements.

Include Alt Text With All Visuals
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text helps people who can’t see the screen to 
understand what’s important in images and other visuals. 

 » How: Control + Click the image or object > Edit alt 
text > Type 1-2 sentences in the text box to describe 
the object and its context.

Do Not Use Infographics in Place of Text 
Why: Screen readers cannot read images or infographics 
without alt text. Unless your image has alt text, do not send a 
.jpg or PDF as the only item in an email. Another option would 
be to add the text in the image or infographic as text in your 
email.

Add Meaningful Hyperlink Text
Why: People who use screen readers sometimes scan a list of 
links. Links should convey clear and accurate information about 
the destination. For example, instead of linking to the text Click 
here, include the full title of the destination page. 

 » How: Click on the insert link option on the bottom toolbar 
> Insert Link > Write the information about the destination 
in the description > Write the URL in the web address box

Don’t Use Color To Convey Information
Why: People who are blind, have low vision, or are 
colorblind might miss out on the meaning conveyed by 
particular colors.

 » How: Add an underline to color-coded hyperlink 
text so people who are colorblind know the text is 
linked even if they can’t see the color. For headings, 
consider adding bold or using a larger font.

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If you use black or gray text in your 
emails, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background. If 
you struggle to read the email, so will your readers.

Add Table Header And Column Information
Why: To keep track of their location in a table, screen 
readers count table cells and use header information 
to identify rows and columns. If a table is nested within 
another table or if a cell is merged or split, the screen 
reader loses count and can’t provide useful information 
about the table. Blank cells in a table could also mislead 
someone using a screen reader into thinking that there is 
nothing more in the table.

Use A Larger Font Size
Why: People who have dyslexia describe seeing text 
“swim together” on a page (the compressing of one line 
of text into the line below). They often see text merge 
or distort. To reduce their reading load use a larger font 
size, 11pt or larger.

 » How: Click on the font size bar > Select a font size of 
11pt or larger

Include Sufficient White Space
Why: In order to reduce workload for individuals with 
dyslexia, make sure there is ample white space between 
sentences and paragraphs

Request Accessible Emails
Why: If you wish to make sure you receive accessible 
emails, you can let the sender know that you prefer to 
receive accessible content.

 » How: Click the settings icon on your Outlook on the 
web > In the search bar type “Accessible Content” > 
Click on Accessible Content > Select the “Ask senders 
to send content that’s accessible” checkbox > Click 
save

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

https://support.microsoft.com/en-us/office/make-your-outlook-email-accessible-to-people-with-disabilities-71ce71f4-7b15-4b7a-a2e3-cf91721bbacb#PickTab=Windows
www.ndsu.edu/otl/faculty_resources/course_design/course_materials


CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft Word

Use this list to check for common accessibility issues 
in Microsoft Word documents. Microsoft offers in-
depth information on the use of its accessibility checker 
feature as well as step-by-step instructions on how to fix 
accessibility issues, and further explanation on why these 
are important.

Insert Document Titles
Why: Document titles provide information on what a 
screen reader is reading.

 » How: File menu > Properties > Summary > Title > 
Enter descriptive title for your document.

Use Alt Text For All Images
Why: Screen readers cannot read photos without alt text 
or descriptions. Individuals may miss or wonder if they 
have missed important information.

 » How: Click image > Picture Format menu > Format 
Pane > Layout & Properties ( ) > Alt text > Simple 
images, fill in title, Ex: John Doe; Images with words 
or diagrams, fill in title and description box with 
information explaining image significance or what 
text in the image says.

Use Table Headers
Why: Table headers explain the information in columns 
a screen reader reads. Without table headers, a screen 
reader reads, “Accessibility issues, 10, 14, 3” versus “Book 
title accessibility issues, Page 10, Total pages 14, Number 
of follow up questions 3.” 

 » How: Insert menu > Table > Choose columns & rows 
+ 1 extra row > Table Design menu > Ensure Header 
Row box is checked > Type column headers in first 
row of table

Use Headings And Sub-Headings
Why: Provides a logical reading order for screen readers. 
Saves time with accessibility when exporting to a PDF.

 » How: References menu > Add Text > Highlight text to 
classify as heading or sub-heading > Choose Level 1, 
then Level 2, then Level 3 as needed. 

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

 » How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or 
email option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use 70% tint for your gray/black colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

 » How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 
25%” or a lesser percentage. “Lighter 25%” means the 
tint is 75%. If you use anything more than 25% lighter, 
your document will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

 » How: You can use color to differentiate but offer 
another differentiation tool. This could be numbers, 
letters, or other characters.

Watch For Extra Spaces After Words
Why: Extra spaces after words or sentences are read by a 
screen reader as either “space” or “blank.” Neither convey 
meaning and can contribute to confusion.

 » How: Make an effort to NOT add spaces after 
sentences; and, add, “check for extra spaces,” to 
your editing process. Place cursor at the end of each 
paragraph, use the right arrow key to see if there are 
extra spaces, and delete any you find. 

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
www.ndsu.edu/otl/faculty_resources/course_design/course_materials


CREATING 
ACCESSIBLE
DOCUMENTS
Microsoft PowerPoint

Use this list to check for common accessibility issues in 
Microsoft Powerpoint presentations. Microsoft offers in-depth 
information on the use of its accessibility checker feature as 
well as step-by-step instructions on how to fix accessibility 
issues, and further explanation on why these are important.

Use Unique Slide Titles
Why: Individuals using a screen reader skim through 
slide titles to navigate; they quickly scan slide titles and 
go right to the slide they want. Using unique slide titles 
allows them to clearly understand which slide they are on. 
Avoid using the same title for slides that have spill-over 
information, consider including additional information 
such as ‘Slide Title 1 of 2’.

Use Built-in Slide Templates
Why: Built-in slide layout templates are designed so the 
reading order is the same for people with vision and for 
people who use screen readers. 

 » How: Design menu > Select a built-in slide template.

Add Alt Text To All Images, Objects and Tables
Why: For screen reader users, alternative text helps to 
communicate what is important in images and other 
visuals. Alt text provides a textual alternative to non-text 
content.

 » How: Right click the image or object > Format picture/
object > Size & Properties ( ) in the left pane > Alt text > 
fill in title and description explaining the object or image.

Use Table Headers
Why: Table headers explain the information in columns a 
screen reader reads. Without table headers, a screen reader 
would not be able to correctly read the table. 

 » How: Insert menu > Table > Choose columns & rows + 1 
extra row > Table Design menu > Ensure Header Row box is 
checked > Type column headers in first row of table

Set Reading Order Of Slide Contents
Why: Screen readers read the elements in the order they 
were added to the slide, which might be different from the 
order in which things appear. It’s important to check the 
reading order by using the Selection Pane. The reading 
order in the Selection Pane should be arranged from the 
bottom up. The title should be at the very bottom with 
subsequent content above it.

 » How: Home > Arrange > Selection Pane > Arrange the 
reading order by dragging the objects on the right pane.

Use Descriptive Hyperlinks
Why: Descriptive hyperlinks enable users to know what 
information they will receive if they click the link. A 
screen reader reads a link as, “link click here” versus “link 
how to fix accessibility issues.”

 » How: Write a description of what the link provides > 
Highlight link text > Insert menu > Link > Click web or email 
option > Insert web or email address

Use Good Contrast 
Why: High contrast text is easier to read for sighted and 
low sighted individuals. If the document is black and 
white, use at least 70% tint for your gray colors. When 
using color, choose dark colors on a light background or 
light colors on a dark background. If you struggle to read 
the document, so will your readers.

 » How: Font color menu ( ) > Hover cursor over gray/
black color choice > Choose a color that says “lighter 25%” 
or a lesser percentage. “Lighter 25%” means the tint is 75%. 
If you use anything more than 25% lighter, your document 
will be flagged for contrast issues.

Use Multiple Ways To Identify Information
Why: If color is the only way to differentiate between 
items, low sighted, color blind, and sighted individuals 
may struggle to see the difference between each color. 
Variations in colors used by computer monitors and 
printers can be significant; and, when printed in black 
and white, color variation and meaning are lost.

 » How: You can use color to differentiate but offer another 
differentiation tool. This could be numbers, letters, or 
other characters.

Avoid Excess Animation
Why: People can get vertigo or be sensitive to moving 
or flashing images. Because of this, animation should be 
kept to a minimum. Strobing or rapidly moving images 
should be avoided, as this can make certain viewers sick 
or cause a seizure.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials

https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
www.ndsu.edu/otl/faculty_resources/course_design/course_materials


CREATING 
ACCESSIBLE
DOCUMENTS
PDFs

Use this list to make sure the final PDF document is accessible 
when converting documents into a PDF file. The first and most 
important thing is to ensure the document you are converting 
follows all accessibiity standards. Once you have made sure 
there are no accessibility issues, follow these steps. The most 
common adjustments will be discussed below.

Save A Document As PDF
Why:. In order to preserve the accessibility changes made in 
the PowerPoint or Word document, the PDF conversion has to 
be done in a specific way.

 » How(For Mac): Click file > Save As > Select PDF from the 
file format dropdown > In Microsoft word check the box 
labeled “Best for electronic distribution and accessibility” 
> Save.

 » How(For Windows): Click file > Save As > Select PDF 
from the file format dropdown > Options > In Microsoft 
word check the box labeled “Document structure tags for 
accessibility” > Ok > Click save.

Use The Accessibility Checker Feature
Why: The Accessibility Checker feature will automatically check 
to see if there are any accessibility errors. If you have used the 
accessibility checker features in other platforms, you will have 
minimal adjustments to make in a PDF. 

 » How:  Click Tools > Accessibility > Accessibility Checker > 
Start checking > The system will automatically check for 
accessibility issues and show if there are any issues. To 
resolve issues simply Right Click on the unresolved issue 
> Click Fix.

Add A Title To The Document
Why: Having a document title makes it easier for someone using 
a screen reader to know what document they are listening to. If 
you missed this, you can still do this during the PDF accessibility 
check.

 » How: Click Document > Title > Control + Click > Fix > 
Uncheck “Leave as is” and change document title.

Set The Appropriate Reading Language
Why: An appropriate language must be selected in the PDF 
properties so that the screen reader knows what language to 
read in. 

 » How: Click File > Properties > Advanced > Reading 
Options > Select “English” or the appropriate language the 
document is written in. 

Make Sure The Document Uses High Contrast
Why: Make sure that the document is in high contrast so 
that the text is easier to read for sighted and low sighted 
individuals. This means dark text on a light background or 
light text on a dark background.

 » How(For Mac): Open File in Adobe Acrobat DC > Click 
Acrobat Pro DC > Preferences > Select Accessibility > 
Check the “Replace Document Colors” box > Select “Use 
High-Contrast Colors“ > From the dropdown list select 
“black text on white”.

 » How(For Windows): Open File in Adobe Acrobat DC > 
Click Edit > Preferences > Select Accessibility > Check 
the “Replace Document Colors” box > Select “Use High-
Contrast Colors“ > From the dropdown list select “black 
text on white”.

Set The Reading Order
Why: Since the reading order is unique to each document, 
the accessibility checker is unable to fully check the reading 
order. Double check that the PDF is reading the document in 
the intended order. 

 » How: Click Tools > Accessibility > Accessibility Checker 
> Reading Order > Show Order Panel > Review the 
numerical order for each page. For items a screen reader 
would not read, click + ctrl or right click on the number of 
the item in the side panel. From the menu, choose what 
type of content it is. “Tag as Decorative/Background” will 
indicate that it is not content that adds meaning to the 
document.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/course_design/course_materials
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LITTLE 
HINTS FOR 
INSTRUCTORS

Get off to a great start and keep the momentum going 

with these helpful hints for your classes this semester.

 Week 1
TIP 1: Check on your books and materials in the NDSU 
Bookstore to ensure the books are in and there are 
adequate numbers for your course enrollment. 
TIP 2: Provide a tour for your students in Blackboard 
to show them how you will use it and where to find 
important items. You can do this during a class session, 
record a video and post it in Blackboard, or provide a 
written guide.

   Week 2
Administer a survey to get to know your students better 
and support their learning. A survey template is available 
in the Qualtrics NDSU Library. See sample items. 
(https://drive.google.com/file/d/1RmqzI9yZWTOz2mMqzwiE4K31LL-kcwrm/view)

   Week 3
Help your students get to know one another by using 
group activities to learn the content and allotting the 
first minute or two for introductions and sharing. 

   Week 4
Your students will learn better and are more likely to 
retain the information when they can experience the 
content by seeing, hearing, saying, and writing. We often 
only plan for the seeing and hearing. Include activities 
during class that allow students to write and speak about 
the content.

   Week 5
Learn more about the Student Course Experience 
Surveys your students will be asked to complete at the 
end of the semester. 
(https://www.ndsu.edu/gdc/qualtrics/student_rating_of_instruction_srois/)

   Week 6
Spring semester course materials orders are due 
November 1st. The NDSU Bookstore is required by law 
to list all course materials for all NDSU courses.

   Week 7
Prepare and administer a midterm feedback questionnaire 
in your classes. A survey template is available in the 
Qualtrics NDSU Library. It can be as simple as this.
(https://drive.google.com/file/d/1EYWHdHSzNE9PTvXbnxo19swOD3Yud69d/view)

   Week 8
Share the midterm feedback and how you will address 
any concerns with your students so they know you are 
listening.

   Week 9
Students will learn more when they receive narrative 
feedback that tells them what they are doing well and 
how they can improve.

   Week 10
Want help building your final assessment? Consultants 
in the Office of Teaching and Learning can help, whether 
it’s a traditional exam or a performance assessment. 

   Week 11
Keep notes about what is going well with your class and 
what you want to change for next time. We think we will 
remember, but when it gets busy, it’s easy to forget. 

   Week 12
Have you kept your grade center up to date?  If not, now’s 
a good time to catch up and communicate with students 
to let them know where they are at in the class. 

   Week 13
Sign up for Peer Teaching Partnership for the next 
semester. Select either the formal or informal track. 
Learn more.   (www.ndsu.edu/otl/programs/peer_teaching)

   Week 14
Set your students up for success by holding office hours 
for additional study time for the final exam or, if students 
are completing projects, workshop time to consult with 
you and receive feedback. 

   Week 15
Avoid getting numerous emails from students by posting 
the timeline for posting grades for the final assessment 
and course. 

   Week 16
Even though it’s tempting to disconnect immediately 
after finishing up the class, take a few minutes to revise 
your syllabus for next time while everything is still fresh 
in your mind.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl/faculty_resources/getting_started
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PERFORMANCE 
OBJECTIVES 

What are instructional objectives? 
Also often referred to as learning objectives and 
performance objectives.

 » Instructional objectives are specific, measurable, 
short-term, observable student behaviors. 

 » An objective is a description of a performance 
you want learners to be able to exhibit before you 
consider them competent.

 » An objective describes an intended result of 
instruction, rather than the process of instruction 
itself.

Writing objectives for using Bloom’s 
Taxonomy and associated action or 
performance verbs.

Parts of a performance objective:    
Answer the question: “What should the students be able 
to do?”

Objective:  The students will be able to infer the 
developmental needs of a child by documenting evidence 
aligned with developmental theory.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

What should the students be able to do?

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

Sample Performance Objectives:
 » The students will be able to draw inferences about 
the causes of WWII.

 » The students will be able to identify the verbs in 
sentences.

 » The students will be able to explain the purpose of a 
given text.

 » The students will be able to apply the principles of 
design to a poster.

 » The students will be able to categorize rocks by type.
 » The students will be able to describe the habitats of 
various animals.

 » The students will be able to predict the outcome of 
habitat changes.

 » The students will be able to accurately measure wet 
and dry ingredients.

 » The students will be able to select the correct plant 
types to be grown in a particular environment.

The following are NOT observable or measurable 
performance objectives:

 » Appreciate the beauty of a circuit 
 » Understand relativity theory 
 » Be familiar with the law 
 » Understand the process of osmosis 
 » Enjoy speaking French
 » Learn about erosion
 » Listen to the lecture

The students 
will be 
able to

determine the 
development 
needs of a child

by documenting 
evidence 
aligned with 
developmental 
theory.

Audience:
Standard 
introduction 
for an 
objective.

Hint:  Focus on 
the students, not 
the teacher.

Behavior/Action 
Verb that is 
measurable and can 
be assessed.  What is 
the learner to do?

Content- description 
of the subject matter 
to be learned.

Hint:  Must specify 
observable and 
measurable behaviors.

Condition to 
be met by the 
students in order 
to demonstrate 
that the objective 
has been 
achieved.

Hint:  Describes the 
circumstances, situation 
or setting.

Adapted from resources found at:
www.bu.edu/cme/forms/RSS_forms/tips_for_writing_objectives.pdf
https://tips.uark.edu/using-blooms-taxonomy/



Example

The students will determine the developmental needs 
of children across all domains.

 » Student-centered—it states specifically what that 
students will be able to do.

 » It includes a measurable action verb
 » It identifies the content aligned with program goals.
 » Student friendly—it isn’t overly technical, and is 
easily understood by students.

A program goal/outcome from which this course 
objective is derived may look like:

 » Students will understand developmental domains.

WRITING 
COURSE 
OBJECTIVES

What are course objectives?
Course objectives directly state what the students 
will know or be able to do by the end of the course. 
They ensure the instructor and students have a clear 
path through the course. All learning experiences and 
assessments should align to the course objectives.

Course objectives are:
 » Specific
 » Concise
 » Student-centered
 » Measurable
 » Student-friendly
 » Aligned with program objectives/goals

What does a course objective look like?

How are course objectives different from 
individual session objectives?
The learning objectives for an individual course session 
are at a more granular level than an overall course 
objective and lead the student toward the corresponding 
course objective.

For example:
Course Objective— The students will determine the 
developmental needs of children across all domains.

 » Session Objective—The students will recall the 
developmental domains. (knowledge)

 » Session Objective—The students will list the 
common characteristics of the stages of cognitive 
development. (knowledge)

 » Session Objective—The students will recognize 
developmental delays. (evaluate)

 » Session Objective—The students will create a therapy 
plan for a child with developmental delays. (synthesis)

Learning Level Associated Action Verbs

Knowledge

define, describe, state, list, name, 
write, recall, recognize, label, 
underline, select, reproduce, 
outline, match

Comprehension

identify, justify, select, indicate, 
illustrate, represent, name, 
formulate, explain, judge, contrast, 
classify

Application
predict, select, assess, explain, 
choose, find, show, demonstrate, 
construct, compute, use, perform

Analysis

analyze, identify, conclude, 
differentiate, select, separate, 
compare, contrast, justify, resolve, 
break down, criticize

Evaluation

judge, evaluate, determine, 
recognize, support, defend, attack, 
criticize, identify, avoid, select, 
choose

Synthesis/
Create

combine, restate, summarize, 
precise, argue, discuss, organize, 
derive, select, relate, generalize, 
conclude

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

Note: the action verb guides assessment. For example, 
knowledge-level learning can be measured through 
limited-response quizzes or tests; while higher level 
learning can be measured with constructed response 
and projects.

Bloom’s Taxonomy
Although there are several taxonomies for learning, 
Bloom’s is the most widely known and used. Bloom’s 
Taxonomy serves as a useful resource for identifying 
the action verb needed for writing effective objectives. 
The following chart provides the six learning levels and 
examples of aligned performance verbs.



TIPS FOR 
FILMING 
VIDEOS

Whether you are filming a lecture for your class or a 
video for YouTube, there are some strategies you can use 
to ensure your video is of good quality. A video of good 
quality makes it easier for the viewer to receive your 
message. 

Here are a few tips to ensure your video is of good quality.

Plan your video in advance
Planning your video in advance provides numerous 
advantages in terms of quality. The most important 
reason is that it decreases the amount of time spent 
filming and editing your video.  

Follow a script
Write a script before recording, the script entails what 
you will talk about in the video. The video needs to be 
short, concise and to the point. So, write your script 
keeping that in mind. 

Use good lighting
Preferably record In a shady area that will give a softer 
light. Avoid overhead lighting because that will cause 
harsh shadows on the subject’s face. 

Use a clean background
An easy way to do this is to have a solid-colored 
background like a blank wall. If you do not have or do 
not want to use a clean background, be sure to check 
that background elements in the camera frame are 
representative of the message you want to send and are 
not distracting.

Film with minimal background noise
Depending on the microphone sensitivity, lots of times 
microphones will record random noises like a fan, traffic, 
or background conversations. Record in a place free 
from those background noises. 

Have good audio recording device
Borrow a microphone if needed and connect it to 
the camera. The Office of Teaching and Learning has 
microphones available to borrow.

Avoid shaky footage
It is not possible to have the camera handheld and 
not have shaky footage. It is best to use a tripod or set 
up a camera on a flat surface so your footage looks 
professional. The Office of Teaching and Learning has a 
tripod available to borrow. 

Record with the best quality
Minimum quality should be 1080 pixels (px) at 30 frames 
per second (fps). Check your camera or phone to ensure 
it is recording at these settings. If you are using a phone 
to record be sure you have it set up horizontally rather 
than vertically. 

Appear natural in front of the camera
Try to appear as natural as possible. Use open body 
language. Maintain good posture. Keep your shoulders 
relaxed. Avoid crossing your arms since this makes you 
look closed-off. 

Speak slower
Individuals have a tendency to speak faster when they 
are on camera or in front of a crowd. Before you begin 
speaking pause and remind yourself to speak slower and 
enunciate tricky words. 

Make sure to smile
A smile, especially at the beginning of the video, offers a 
sense of warmth and appears welcoming.

Look at the lens
Be sure to look at the lens of your camera or the general 
direction of the camera on your computer this is how your 
eyes will connect with your viewers eyes. If recording 
from your computer, it may help to tape a photo of a 
person near the lens. 

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl



GETTING OFF
TO A
GOOD START
Helping All Learners Feel Welcome

The learning environment sets the stage for learning. 
Here are a few ways to set up your learning environment 
to make your learners feel welcome and able to learn.

Comfortable Seating
Think of comfort broadly.
 » The seating should establish opportunities for 

students to see and be seen and feel like they belong 
in the classroom. 

 » Can the seating be arranged in a circle to all allow 
learners to see one another?

 » Another option is to arrange the seating around a 
table or put desks in pods to encourage discussion 
and collaboration.

 » Can you position yourself as the instructor in ways 
that allow you to be close to your learners, make eye 
contact, and see and hear them when you are talking 
and eliciting their ideas?

Look and Feel of the Room 
Unlike our K-12 educator colleagues, higher education 
instructors typically don’t have their own classroom 
that can be customized to have a warm or personalized 
look and feel. However, there are things we can do to 
personalize the space we use. 

For example:
 » You can project an image and/or message that 

students see when they enter the room.
 » You can add a message to the whiteboard, welcoming 

students and/or giving them something to think 
about related to the day’s learning.

 » Another idea is to create learner toolkits that can 
be housed in the classroom or brought with you to 
class that include items that support thinking and 
discussion such as a mini-whiteboard, discussion 
prompts, response cards (Yes, No, Need More 
Information), activity protocols, resource sheets like 
a conversion chart or glossary, etc. 

 » Finally, consider creating a personal introduction 
for your students and inviting them to do the same. 
For example, post a photo and brief welcome that 
includes a glimpse into your interests and hobbies.

Communication
Although Zoom and Teams meetings have made us more 
aware of the expressions on our faces and how the way 
we look may be perceived, educators are often under-
aware of their non-verbal communication and tone. Plan 
for intentionality.
 » Position yourself near your students and work the 

room, so you aren’t only interacting with the students 
in your “splash zone.”

 » Practice holding a warm, interested, and friendly 
expression on your face. 

 » Make eye contact with your students to show them 
you are listening and paying attention to them.

 » Don’t be afraid to make a mistake or admit you do not 
know something. Instead, share with the students 
how you corrected the mistake or how you will learn 
what you don’t know.

 » Finally, review your syllabus for messaging; perhaps 
even invite a colleague to review it, letting you 
know the tone they feel. Can you set high and 
clear expectations while maintaining a warm and 
approachable tone?

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl
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GETTING OFF
TO A
GOOD START
Engaging Learners

Engagement is predictive of several positive academic 
and life outcomes including academic achievement, 
reduced drop-out rates, greater satisfaction with life, 
and a better overall sense of well-being. In fact, without 
opportunities for students to connect with learning in 
meaningful ways, they don’t learn. So, how can you make 
engagement more likely? 

Engagement by design is an intentional approach to 
planning built upon the principle that every student 
deserves a learning experience with high levels of 
engagement. 

Classroom Relationships  
Relationships are among students and the content, 
peers, and instructor. Students are more likely to form 
a relationship with content when they can see how it is 
relevant, interesting, and useful. Positive relationships 
with peers that support engagement and learning require 
time and structure. Structure includes establishing 
guidelines for interaction that include respectful speaking 
and listening and worthwhile activities. Roger and David 
Johnson are experts in the field of cooperative learning 
with excellent resources on structuring collaborative 
interactions. Trust is the foundation of forming a 
relationship with your students. Trust is fostered when 
students see you as competent, which includes both 
knowing what you’re talking about and delivering on 
your promises. Students also trust instructors more 
who provide the instruction and feedback they need to 
succeed. In addition, relationships can be fostered with 
your students through sharing appropriate but personal 
information such as a photo and brief welcome that 
includes a glimpse into your interests and hobbies and 
inviting them to do the same.

Learner Voice
This includes listening, learning, and leading. Learners 
need to be taught how to listen to one another and 
provided with the structure for listening that includes 
expectations and modeling of respect and active listening.  
After hearing the ideas and perspectives of others, 
learners should be given the opportunity to demonstrate 
that they heard and learned from that experience. Finally, 
learners need opportunities in class to take responsibility 
for their own and others’ learning—not just passively 
intake content from the educator.

For more information or assistance, contact:

NDSU Office of Teaching and Learning
701-231-7015   |   ndsu.otl@ndsu.edu
www.ndsu.edu/otl

Student Value
Students need to feel like they belong along with being 
recognized, appreciated, and celebrated. Value is 
cultivated when student growth and accomplishment is 
recognized. Value is also furthered when a student knows 
others believe in them. Keep in mind that recognition can 
be private such as sincere and performance-anchored 
feedback on an assessment. Belief can be conveyed with 
statements that not only tell the student you believe in 
their abilities but also explain how you know this (e.g., “I 
know you can do this. You have the knowledge and skills 
needed to complete this project. Let’s review what you 
know…”)

Clear and Worthy Content
Thoughtfully examine the content included in your class.  
Is it all important? Can you provide a strong rationale if 
asked “Why do we need to know this?” Once the worthy 
content is established, determine how you will clearly 
inform learners what they are expected to learn and what 
the success criteria look like.

Challenging Learning Experiences
Learners need an opportunity to rise to the challenge of 
learning the worthy content. Identify complex questions 
and problems for learners to grapple with. Help learners 
see the relevance in the content and the connections 
across the discipline.

1. Fisher, D., Frey, N., Quaglia, R. J., Smith, D., & Lande, L. L. (2018). Engagement by design: 
Creating learning environments where students thrive. Corwin.

www.ndsu.edu/otl


Notes
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